COMMSCOPE

RUCKUS"®

SOFTWARE INSTALLATION GUIDE

RUCKUS loT Controller
Software Installation Guide, 1.8.2.0 MR

Supporting loT Controller Release 1.8.2.0

Part Number: 800-73057-001 Rev A
Publication Date: October 2021



Copyright, Trademark and Proprietary Rights Information

© 2021 CommScope, Inc. All rights reserved.

No part of this content may be reproduced in any form or by any means or used to make any derivative work (such as translation, transformation, or
adaptation) without written permission from CommScope, Inc. and/or its affiliates ("CommScope"). CommScope reserves the right to revise or
change this content from time to time without obligation on the part of CommScope to provide notification of such revision or change.

Export Restrictions

These products and associated technical data (in print or electronic form) may be subject to export control laws of the United States of America. It is
your responsibility to determine the applicable regulations and to comply with them. The following notice is applicable for all products or
technology subject to export control:

These items are controlled by the U.S. Government and authorized for export only to the country of ultimate destination for use by the ultimate
consignee or end-user(s) herein identified. They may not be resold, transferred, or otherwise disposed of, to any other country or to any person other
than the authorized ultimate consignee or end-user(s), either in their original form or after being incorporated into other items, without first
obtaining approval from the U.S. government or as otherwise authorized by U.S. law and regulations.

Disclaimer

THIS CONTENT AND ASSOCIATED PRODUCTS OR SERVICES ("MATERIALS"), ARE PROVIDED "AS IS" AND WITHOUT WARRANTIES OF ANY KIND,
WHETHER EXPRESS OR IMPLIED. TO THE FULLEST EXTENT PERMISSIBLE PURSUANT TO APPLICABLE LAW, COMMSCOPE DISCLAIMS ALL
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, TITLE, NON-INFRINGEMENT, FREEDOM FROM COMPUTER VIRUS, AND WARRANTIES ARISING FROM COURSE OF DEALING
OR COURSE OF PERFORMANCE. CommScope does not represent or warrant that the functions described or contained in the Materials will be
uninterrupted or error-free, that defects will be corrected, or are free of viruses or other harmful components. CommScope does not make any
warranties or representations regarding the use of the Materials in terms of their completeness, correctness, accuracy, adequacy, usefulness,
timeliness, reliability or otherwise. As a condition of your use of the Materials, you warrant to CommScope that you will not make use thereof for
any purpose that is unlawful or prohibited by their associated terms of use.

Limitation of Liability

IN NO EVENT SHALL COMMSCOPE, COMMSCOPE AFFILIATES, OR THEIR OFFICERS, DIRECTORS, EMPLOYEES, AGENTS, SUPPLIERS, LICENSORS AND
THIRD PARTY PARTNERS, BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, EXEMPLARY OR CONSEQUENTIAL DAMAGES, OR
ANY DAMAGES WHATSOEVER, EVEN IF COMMSCOPE HAS BEEN PREVIOUSLY ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, WHETHER IN AN
ACTION UNDER CONTRACT, TORT, OR ANY OTHER THEORY ARISING FROM YOUR ACCESS TO, OR USE OF, THE MATERIALS. Because some jurisdictions
do not allow limitations on how long an implied warranty lasts, or the exclusion or limitation of liability for consequential or incidental damages,
some of the above limitations may not apply to you.

Trademarks

ARRIS, the ARRIS logo, COMMSCOPE, RUCKUS, RUCKUS WIRELESS, the Ruckus logo, the Big Dog design, BEAMFLEX, CHANNELFLY, FASTIRON, ICX,
SMARTCELL and UNLEASHED are trademarks of CommScope, Inc. and/or its affiliates. Wi-Fi Alliance, Wi-Fi, the Wi-Fi logo, Wi-Fi Certified, the Wi-Fi
CERTIFIED logo, Wi-Fi Protected Access, the Wi-Fi Protected Setup logo, Wi-Fi Protected Setup, Wi-Fi Multimedia and WPA2 and WMM are
trademarks or registered trademarks of Wi-Fi Alliance. All other trademarks are the property of their respective owners.

RUCKUS IoT Controller Software Installation Guide , 1.8.2.0 MR
2 Part Number: 800-73057-001 Rev A



Contents

PrEFACE. . uviieertieeiitieennttenisetsesseeesesnessesntssessasesessnsessssasesossasssssssssssssssssssssnsessssastsssssstessssstsssssntsssssatesessasesessastsessastsessestessssstessssastesssatessssasesssssasns 5
Contacting RUCKUS CUStOMET SEIVICES aNT SUPPOIT.......eiiieerieireeiteeeeeeiteeiteeeteesteeeteeseesseesssesseesseesssessesesssesssessesssssssessssssssesssessseesssesssesssesseesseesnes 5
WHat SUDPPOIE DO I INEEA?.... ..ottt ettt ettt e e e te e e st e e e s beeeeabaeesasseeessaeeasssaaassaseessasesssasaasssseassasesssaeeansaseassseeesaaeasssasensseeenssaesnsseeannes 5
Open aCase....ccceeeurvvnennn.
Self-Service Resources
DOCUMENT FEEADACK. ... eeiiieeiieteeieee ettt s te et e st e st e et e e te et e eeseeesae e seeaseesseesasaanseesseessseanseesseeasseanseenseanseeasaesssaanseenstennsasnsesnseenssenssnenses 6
RUCKUS Product DOCUMENTAtION RESOUICTES........ccvereieeriiesieeeieesteesteestestessseesseesstesssasseesseesseessseensessssesssesssessseesseesssesssessseessssssseessesssessssesssesssessseennen 6
Online Training Resources.
DOCUMENT CONVENTIONS. ... uiiitieiieeeiieieeeteeite et esteesteeseeeseesseasssessseaseessaessseasssasssesssasssessssasssesssesssessssasssesssesssesssesssessssesnsessssesseesssessseesseesssenssensssenseen
Notes, Cautions, aNd SAfELY WaAIMINGS.........eccuiiiiieeieeieecieeeeesteete et e seesteestessteesseesssesseeseessaessseasseasseessseasseasseesseeassesssessseasssesssessessseesssensennes 7
COMMANA SYNEAX CONVENTIONS. ....ccuviiiireeietieeeitteeeitteeerteeeerteeeeeteeeessreeessseeeesseeesssseesssseesssseeassseeassseeassseesssseeesssseesssseesssesassseessseseessseeessseessssensseensseeens 7
ADOUL TS GUILE......eiiiiuiiiiiiiiiiiiiiiiieteneierenesseresesssessessssssesssssssssssessssssessssnssssssssssssssssssssssssssssassssssassssssssssssssssasssssssssssssassssssssssssssssssssssssssasassssans 9
INtrOdUCEION t0 RUCKUS 10T CONEIOIIET ... c..titieiieieieeieitertestetesteete et este st e stesteste st estesaeessessassasssessesssessensassesssensesssensensassesssensesssessensesssesensesseensensanses 9
What's NEW iN THIS DOCUMENT....c..ccctirtieieitertertestenieetestestestesessesseesessesseessessesseessessessesssensessesssessessesssensesseessensesseessensensesssensessesssessessesssensessesssensanses

Summary of New Features in RUCKUS loT Controller 1.8.2.0 MR

Installing RUCKUS 10T CONtroller 0N HYPEIVISOI.........uuuiiiiieeeiireeeeteeeeeeesreeeeeeeessesssssesseesssssssssssssesssssssssssesesssssnns 11
System Requirements for Installing RUCKUS 10T CoONtroller 0N @ HYPEIVISOI..........oii ittt ettt eiteeeetae e e aae e e steeeeaaeeeenseeeessaaennseaens 11
Hardware Recommendations fOr the IOT SEIVET ..........i ettt ettt et este st e et e st e et e e st essaeesseesse e saesseeessesnseanseesssesnsesseasseesnsenns 11
Installing RUCKUS 10T CONtIOIIEr ON @ VIMWAIE ESXi.....cccuviieiiiiieiieeeiieeeiteeeieeeetteeeeteeeeeteeeeetaeeeetaeeeesaeesesseesesseesesssasassseeesseseessseaansseeansaseesssaansseesnns 12
Installing @ KVM Guest USING VIrSh COMMANGS..........ccciieiiieiieeieeiteeciestestesste e st eseeesaeeseesseesseesssesseesseesssessseasseesseesssessseenseessseessessseesssenssessseesseesnen 23
Installing a KVM Guest Using Virtual Maching Man@gET ..........ueccuiecuierieeieecieestesteestessteesteeseesteseseesseesssesseeseesssassseasseesseasseesssesssessseesssesssensseensen 23
Installing RUCKUS loT Controller on Hyper-V....
INSEAIIING HYPEI-V ...ttt ettt et ete et e st e st e s te e b e e ssaeesbeasse e saeasseassesssaasssesssesssaanseassaeasseasssansaeasseasseenseesssaasseassannsaanssesssanssensseesssenssennen
Creating @ NEW VIrtUAl MaChiNE.......ccuiiiieeieceecteeeeeee ettt e st e et e bt e s e e e taeeae e be e seessaeesbaesssassseesseasseesssesssaesseesseesaaasseansaensaeseesssenssennseesnn
Installing RUCKUS loT Controller on AWS 47
Creating an ACCOUNT WILI AWS...... ..o ittt ettt ecte et te e e teebe e beeetsesaseebaesseessseesse e sa e saessseessaesssessaeesseesssensseassessssessaenseenssessseessaenseesssennseanes 47
IMIPOIEING TNE VRIOT IMAEE...cuiiiiiiiieieiie et eetteeetteeette e e eteeeerteeeetre e e uae e e saeaessaaeassssaesaaeassseeassseeesaseassseanssaeessaeassseenssessasssesnssssenssaeeasssesassaeanssnaens 48
Creating a RUCKUS 10T CONErOIEr EC2 INSEANCE......cccuiieiiiieeiieeetee ettt ettt eette e et e e eveeeeetaeeesaee e aae e e saaeesssseessseeaassssesseesassessasseassssesassessasssesnnsnaannses 49
UPSFading the SOftWAIE.........eveeeieeeiecieteeeteccccceteeeeeeeeceseeeeeeeeessesssasaesessssssssssassessssssssssseseessssssssssasseesassssssssaseessssssssssssesessssssssssseesessssssssaseeessnnssnne 53
Upgrading the AP Firmware Using SmartZone 100 or Virtual SmartZone CoNtrollEr...........oouiiieiieceeeeeee ettt et e e e e sae e 53

Upgrading the RUCKUS IOT CONEIOIIET...........eii ettt ettt ettt e e e te e e eteeeebeeeeabaeeesaeeeseaaesssee e saseeessaeassaessseesssaesassseasseesesseesanseenannes
Upgrading the RUCKUS loT Controller with N+1 Configuration

HOt UPZrade Of 10T GAtE@WAY.......cceeiiiieeeerrereeeieeeeersnreeeeeseesssssseesesssssssssssssssssssssssssesssssssssssnssssssssssssssssesssssssssssssssssssssssssnnsesssssssssssnsesssssssssssnnsessessss 61
DEPIOYING th@ APS.....cueeeiieeeiereeeieeeeeeerreeeeeeeeseessneeeeeeassessssssesesssssssssssesssssssssssnssesssssssssssnnssssssssssssnnsessssssssssnnssassssss 63
Connecting a Set of 10T APs USINg @ GroUPING MELNOM.......c..eiciiiiiiiiieciecece ettt ettt e rte e te e e e e e beesbeesseesaeesseesseesssesssassseesaessseenseesennseenns 63
MaNAGING @ LICENSE. ....uuueeeeieeeeiiirireeteeeereesiseeeeeeessessssseeaeeessssssssssssessssssssssssssssssssssssssssesssssssssssssssssssssssassasesssssssnnsans 65
ACEIVATING @ LICENSE....ceeviiieiiieciiee ettt eet e e bt e et ee sttt eesabae e sbee e sbeeeasaaeaassaeessaeeassseaassseeassaeeassaeanssseeassseesssaeeassseeassseesssaeesssseeassseeensaseessseeenssees 65

RUCKUS IoT Controller Software Installation Guide , 1.8.2.0 MR
Part Number: 800-73057-001 Rev A 3



RUCKUS IoT Controller Software Installation Guide , 1.8.2.0 MR
Part Number: 800-73057-001 Rev A



Preface

e Contacting RUCKUS Customer SErvices and SUPPOIt........cocuiiiiiiiiieiiieeiieeecitee ettt ee sttt e ettt e estaeeessaeesssseessssaesssseesssseesssseesssssesssses 5
©  DOCUMENT FEEADACK. ... eiiiiiiie ittt e et e e bt e e e ta e e s ba e e ebaeeessbaeessbeeessbeeessbaeesssee s sseeessaeesseeesseeenssaeansses 6
o RUCKUS Product DOCUMENTAtION RESOUICES.......ccouviiiiiiieiiiiieeiie ettt eeiteeeieeeeteeeetteesstaeesbaeesssaeassseeesseeessaesssseesssseesnssaeessseeans 6
©  ONIINE TraINING RESOUICTES. ...ccuviieiiiieieitieeeiie e ettt eeiteeesiteeeetaeeessbeeessseeeasbeeeassaaessseeesssseasssseesssseeesssaessseessseeensssessseesasseeensssaansseeans 6
° DOCUMENT CONVENTIONS. ... tiiiiiiieeiieeeitee ettt e et e erteeeetteeeetbeeessbeeessbeeeassaeaassseeasseseassseaasssaeasssseasssaeassseeassseeessaeessseeensseesssseeensseeans 7
©  COMMANA SYNTAX CONVENTIONS. ...uvviieeeeeirieeeeeeiittreeeeeeetereeeeeeirareeeeeesssaseeeseassssseseeeessssesesessssseeessessssseesaenssssseeesessssseeesesssssseeeesnnes 7

Contacting RUCKUS Customer Services and Support

The Customer Services and Support (CSS) organization is available to provide assistance to customers with active warranties on their RUCKUS
products, and customers and partners with active support contracts.

For product support information and details on contacting the Support Team, go directly to the RUCKUS Support Portal using https://
support.ruckuswireless.com, or go to https://www.ruckuswireless.com and select Support.

What Support Do | Need?

Technical issues are usually described in terms of priority (or severity). To determine if you need to call and open a case or access the self-service
resources, use the following criteria:

e  Priority 1 (P1)—Critical. Network or service is down and business is impacted. No known workaround. Go to the Open a Case section.

e  Priority 2 (P2)—High. Network or service is impacted, but not down. Business impact may be high. Workaround may be available. Go to
the Open a Case section.

e  Priority 3 (P3)—Medium. Network or service is moderately impacted, but most business remains functional. Go to the Self-Service
Resources section.

e  Priority 4 (P4)—Low. Requests for information, product documentation, or product enhancements. Go to the Self-Service Resources
section.

Open a Case

When your entire network is down (P1), or severely impacted (P2), call the appropriate telephone number listed below to get help:
e Continental United States: 1-855-782-5871
e Canada: 1-855-782-5871

e  Europe, Middle East, Africa, Central and South America, and Asia Pacific, toll-free numbers are available at https://
support.ruckuswireless.com/contact-us and Live Chat is also available.

e  Worldwide toll number for our support organization. Phone charges will apply: +1-650-265-0903

We suggest that you keep a physical note of the appropriate support number in case you have an entire network outage.

RUCKUS IoT Controller Software Installation Guide , 1.8.2.0 MR
Part Number: 800-73057-001 Rev A


https://support.ruckuswireless.com
https://support.ruckuswireless.com
https://www.ruckuswireless.com
https://support.ruckuswireless.com/contact-us
https://support.ruckuswireless.com/contact-us

Preface
Document Feedback

Self-Service Resources
The RUCKUS Support Portal at https://support.ruckuswireless.com offers a number of tools to help you to research and resolve problems with your
RUCKUS products, including:

o  Technical Documentation—https://support.ruckuswireless.com/documents

e  Community Forums—https://forums.ruckuswireless.com/ruckuswireless/categories

e  Knowledge Base Articles—https://support.ruckuswireless.com/answers

e  Software Downloads and Release Notes—https://support.ruckuswireless.com/#products_grid

e  Security Bulletins—https://support.ruckuswireless.com/security

Using these resources will help you to resolve some issues, and will provide TAC with additional data from your troubleshooting analysis if you still
require assistance through a support case or RMA. If you still require help, open and manage your case at https://support.ruckuswireless.com/
casefmanagement.

Document Feedback

RUCKUS is interested in improving its documentation and welcomes your comments and suggestions.
You can email your comments to RUCKUS at #Ruckus-Docs@commscope.com.

When contacting us, include the following information:
e  Document title and release number
e  Document part number (on the cover page)
e  Page number (if appropriate)
For example:
e  RUCKUS SmartZone Upgrade Guide, Release 5.0
e  Part number: 800-71850-001 Rev A
e Page7

RUCKUS Product Documentation Resources

Visit the RUCKUS website to locate related documentation for your product and additional RUCKUS resources.

Release Notes and other user documentation are available at https://support.ruckuswireless.com/documents. You can locate the documentation by
product or perform a text search. Access to Release Notes requires an active support contract and a RUCKUS Support Portal user account. Other
technical documentation content is available without logging in to the RUCKUS Support Portal.

White papers, data sheets, and other product documentation are available at https://www.ruckuswireless.com.

Online Training Resources

To access a variety of online RUCKUS training modules, including free introductory courses to wireless networking essentials, site surveys, and
products, visit the RUCKUS Training Portal at https://training.ruckuswireless.com.

RUCKUS IoT Controller Software Installation Guide , 1.8.2.0 MR
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Document Conventions

Preface
Command Syntax Conventions

The following table lists the text conventions that are used throughout this guide.

TABLE 1 Text Conventions

Convention Description
monospace Identifies command syntax examples
bold User interface (Ul) components such

as screen or page names, keyboard
keys, software buttons, and field
names

italics Publication titles

Notes, Cautions, and Safety Warnings

Example
device (config) # interface ethernet 1/1/6

On the Start menu, click All Programs.

Refer to the RUCKUS Small Cell Release Notes for more information.

Notes, cautions, and warning statements may be used in this document. They are listed in the order of increasing severity of potential hazards.

NOTE

A NOTE provides a tip, guidance, or advice, emphasizes important information, or provides a reference to related information.

ATTENTION

An ATTENTION statement indicates some information that you must read before continuing with the current action or task.

CAUTION
A A CAUTION statement alerts you to situations that can be potentially hazardous to you or cause damage to hardware, firmware,

software, or data.

DANGER
A A DANGER statement indicates conditions or situations that can be potentially lethal or extremely hazardous to you. Safety labels are
also attached directly to products to warn of these conditions or situations.

Command Syntax Conventions

Bold and italic text identify command syntax components. Delimiters and operators define groupings of parameters and their logical relationships.

Convention Description

bold text Identifies command names, keywords, and command options.
italic text Identifies a variable.

[] Syntax components displayed within square brackets are optional.

Default responses to system prompts are enclosed in square brackets.

{x|yl z} A choice of required parameters is enclosed in curly brackets separated by vertical bars. You must select one of the options.
x|y A vertical bar separates mutually exclusive elements.
<> Nonprinting characters, for example, passwords, are enclosed in angle brackets.

Repeat the previous element, for example, member[member...].

\ Indicates a “soft” line break in command examples. If a backslash separates two lines of a command input, enter the entire command at

the prompt without the backslash.
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Introduction to RUCKUS loT Controller

The RUCKUS loT Controller is a versatile, easy-to-deploy service and management component that allows for integration of Internet of Things (loT)
devices and 10T services for a wide range of use cases. It provides a robust, secure, scalable, interoperable, and well-managed general transport
between loT devices and cloud services.

The RUCKUS IoT Controller is an open-programmable framework that exposes northbound APIs and is thereby a highly flexible IoT transport for
RUCKUS partners to integrate a wide range of |oT services and solutions for the enterprise and beyond.

This guide provides information about how to install the RUCKUS loT Controller on a supported hypervisor. Topics include the list of supported
hypervisors and RUCKUS loT Controller installation instructions using the .OVA or .qcow?2 file.

NOTE
If release notes are shipped with your product and the information there differs from the information in this guide, follow the instructions
in the release notes.

This guide is intended for use by those responsible for installing and setting up network equipment. It assumes a basic working knowledge of local
area networking, wireless networking, and wireless devices.

What's New in This Document

Summary of New Features in RUCKUS loT Controller 1.8.2.0 MR

Feature Description Location
Installing loT Controller on AWS Modified the existing content, and new topic " Refer to Installing RUCKUS loT Controller on AWS on
Creating an Account with AWS" is added. page 47

TABLE 2 Summary of New Features in RUCKUS IoT Controller 1.8.1.1 SR

Feature Description Location

No new features added for this release.

Installing RUCKUS loT Controller on Oracle VM This topic is removed for the current relese. -
Virtual Box.

Installing RUCKUS loT Controller using VMware This topic is removed for the current release. -
Player.

TABLE 3 Summary of New Features in RUCKUS loT Controller 1.8.1.0 MR

Feature Description Location

No New features for this release. Minor updates Refer to topics- Supported Hypervisors, Upgrading
the RUCKUS loT Controller, and Upgrading the
RUCKUS IoT Controller with N+1 configuration.
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What's New in This Document

TABLE 4 Summary of New Features in RUCKUS loT Controller 1.8.0.0

Feature

Description

Location

No New features for this release.

Hypervisors.

The Intialization page is changed for all the

Refer to Installing RUCKUS loT Controller on
Hypervisor on page 11

TABLE 5 Summary of New Features in RUCKUS loT Controller Release 1.7.1.0 (Rev A)

Feature

Description

Location

Upgrading the RUCKUS loT Controller
with N+1 Configuration

New steps added

Refer to Upgrading the RUCKUS loT
Controller with N+1 Configuration on

page 58.

10
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Installing RUCKUS loT Controller on
Hypervisor

e  System Requirements for Installing RUCKUS 10T Controller on a HYpervisor..........cocuieeiieeeiieeiiie e et eeveeesvee e 11
e Installing RUCKUS I0T Controller 0n @ VMWAre ESXi....ccouuieiiiieiiieniinieeieete sttt ettt st et esieesiae et esbeesatesanesaseesseesnnesaseenne 12
e Installing a KVM Guest Using Virsh COMMANGS.........ooieiiuiiriirieeieeitenteeteete et eettesite st e bt e st e site s et esseesbsesaseenseeseesseesnsesseenne 23
e Installing a KVM Guest Using Virtual Maching Manager........c.ueeuiiuiirieriieieententeeste ettt st ste et estestesaeesseesasesasessseenseenas 23

e |Installing RUCKUS loT Controller on Hyper-V

System Requirements for Installing RUCKUS loT Controller
on a Hypervisor

The RUCKUS IoT Controller supports a number of hypervisors and requires a virtual machine (VM).

The following table lists the hypervisors (and their release versions) on which you can install the controller.

TABLE 6 Supported Hypervisors

Hypervisor Vendor Version

ESXi VMware 6.0 and later

KVM Linux 2.11.1 or later

Hyper-v Microsoft Windows 6.2 or later
NOTE

For the compatible hardware for the hypervisors listed above, refer to the respective vendors website.

The virtual machine (VM) on which the controller is installed must meet the following requirements:
e  The VM for the VMware ESXi hypervisor must have a minimum of 4 vCPUs, 4 GB RAM, and Fixed 20 GB HDD.
o  The VM for the KVM hypervisor must have a minimum of 4 vCPUs, 4 GB RAM, and Fixed 20 GB HDD.
o  The VM for the Hyper-v hypervisor must have a minimum of 4 vCPUs, 4 GB RAM, and Fixed 20 GB HDD.
e  Ports 80, 123 or NTP, 443, 1883, and 8883 must be open.

Hardware Recommendations for the loT Server

Customers must obtain robust and reliable server hardware that will support a virtualized environment for loT applications with enough headroom
to expand in the future. Each deployment is unique and hardware specifications will need to be adapted to specific needs. For a typical deployment
(e.g. RUCKUS loT Controller, VMware ESXi, Ubuntu Linux server, IP camera VMS, additional IoT VMs or applications), we recommend server
hardware that meets the below specifications:

e CPU: 4 corei7 or equivalent

e Memory: 32 GB

e Hard Disk: 1 TB

RUCKUS IoT Controller Software Installation Guide , 1.8.2.0 MR
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Installing RUCKUS loT Controller on a VMware ESXi

The RUCKUS IoT Controller can be installed on a VMware ESXi hypervisor using an .OVA file.

1. Download the RUCKUS loT Controller distribution package in the .OVA file format from the RUCKUS Support website at https://
support.ruckuswireless.com.

2. Open VMware ESXi and select Virtual Machines from the Navigator pane.

FIGURE 1 Creating or Registering Virtual Machines

vmware ESXi" r00t@10.137.36.15 v | Help v | (CRaey ~
“E Navigator (21 localhost.video54.local - Virtual Machines
v E] Host
Manage 51 Create / Register VM Console Poweron @ Power off | @ Refresh | \ctions (Q search
Monitor ~ Virtual macl Create or register a virtual machine ~ Status ~ Used space ~ Guest 0S ~ Host name ~ HostCPU ~ Host memoryv
&% Virtual Machines - "~ {51 Automation-ubuntu-16.04-installer @ Nor... 1418GB Ubuntu Linux (64-bit) Unknown 0 MHz 0MB
B storage (51 Automation-Stage-Server @ Nor... 11.55GB Ubuntu Linux (64-bit) Unknown 0 MHz 0MB
Q_ Networking ~| {51 Automation-Production-Server @ Nor... 15.48GB Ubuntu Linux (64-bit) Unknown 0 MHz 0MB
") {51 Gateway-Vriot Q Nor... 7.72GB Ubuntu Linux (64-bit) Unknown 0 MHz 0MB
51 IBM-Vriot-1.3.0.0.1 @ Nor... 5.61GB Ubuntu Linux (64-bit) Unknown 0 MHz 0MB
~ {5 QA-visionline @ Nor... 17.27GB Microsoft Windows Se...  Unknown 18 MHz 6.02 GB
B ga-win-dns-200 @ Nor... 11.52GB Microsoft Windows Se...  Unknown 25 MHz 3.93GB
" {51 Gateway-vsz-10019 @ Nor... 29.85GB Other (32-bit) Unknown 0 MHz 0MB
17 items 4

Recent tasks

Task ~  Target ~ Initiator ~  Queued ~ Started ~  Result ~ Completed v v

3. Click Create/Register VM.

RUCKUS IoT Controller Software Installation Guide , 1.8.2.0 MR
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4. Onthe New virtual machine page, click Select creation type, and select Deploy a virtual machine from an OVF or OVA file. Click Next.

FIGURE 2 Select Creation Type Page

ﬁ New virtual machine

vEEEEEEXTHED  Select creation type

2 Select OVF and VMDK files
3 Select storage

4 License agreements

How would you like to create a Virtual Machine?

This option guides you through the process of creating a

Create a new virtual machine
virtual machine from an OVF and VMDK files.

5 Deployment options
6 Additional settin:

Deploy a virtual machine from an OVF or OVA file

Register an existing virtual machine

Back Next Finish
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5.

Click Select OVF and VMDK files, enter a name for the virtual machine, and select the OVF file. Click Next.

FIGURE 3 Select OVF and VMDK Files Page

1 New virtual machine - VRIOT

+ 1 Select creation type

2 Select OVF and VMDK Tiles

3 Select storage
4 License agreements

5 Deployment options
6 Additional settings
7 Ready to complete

Select OVF and VMDK files

Select the OVF and VMDK files or QWA for the VM you would like to deploy

Enter a name for the virtual machine.

| VRIOT

Virtual machine names can contain up to 80 characters and they must be unigue within each ESXi instance.

x @) vriot-1.6.0.0.38. ova

[ Back H Next ‘ Finish ' Can

|
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6. Click Select storage, and select the datastore in which you want to save the configuration and disk files. Click Next.

FIGURE 4 Select Storage Page

741 New virtual machine - [oT - IoT

¥ 1 Select creation type Select storage
+ 2 Select OVF and VMDK files

Select the datastore in which to store the configuration and disk files

bd 3 Select storage

v
o Lo s agraspmnts The following datastores are accessible frem the destination resource that you selected. Select the destinabon datastore for the

+ § Deployment options virtual machine configuration files and all of the virtual disks.

& Ready to complete
Name v | Capacity w | Free v  Type v Thinpro... v | Access e
datastore1 924 GB B07.09 GB VMFS6 Supported Single

1 items

| Back | Finish Cancel
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Click License agreements to accept the terms and conditions of the software license and click Agree.

FIGURE 5 License Agreements Page

741 New virtual machine - loT - loT

v 1 Select creation type
" 2 Select OVF and VMDK files
¥ 3 Select storage

0 ¢ Lcone sroomeris

+ 5 Deployment options
& Ready to complete

License agreements

Read and accept the license agreements

R

RUCKUS WIRELESS, INC.
Ruckus IoT Controller {RIoT Controller) Software License

PLEASE READ THIS SOFTWARE LICENSE CAREFULLY. RUCKUS WIRELESS, INMC. ("RUCKUS™) IS WILLING TO LICE
TO ¥OU (“LICEMSEE") OMLY ON THE COMNDITION THAT THE LICENSEE ACCEPTS ALL OF THE FOLLOWING TERMS ARk
IF A USER ACCEPTS THIS LICENSE, OR DOWNLOADS, USES OR INSTALLS THE SOFTWARE, AS AN EMPLOWEE OF, C
Of COWTRACTOR FOR THE BEMEFIT OF, A COMPANY, THAT COMPANY SHALL BE DEEMED THE LICENSEE AND THE U2
THAT IT HAS THE POWER AND AUTHORITY TO ACCEPT THIS AGREEMENT ON BEHALF OF THE COMPANMY .

BY DOWNLOADING, IMSTALLING AND/OR USING THE SOFTWARE, LICENSEE ACKNOWLEDGES THAT IT HAS READ THIZ
AGREES TO BE BOUND BY ITS TERMS AND CONDITIONS. IF LICENSEE DOES MOT AGREE TO THE TERMS AND CONC
LICENSE, RUCKUS IS UNWILLING TQ LICENSE THE SOFTWARE. 1IN THAT EVENT, LICENSEE MAY HOT DOWNLOAD,
THE SOFTHARE AND SHALL BE GIVEM A FULL REFUND OF ANY LICENSE FEES ACTUALLY PALD FOR THE SOFTWARE.

1) Definitions
“Device" means a single Ruckus access point on Licenses’s network.
“Documentation” means the published technical manuals, including any updates therato, relating tc
avallable by Ruckus.
"evaluation Term™ means the limited period of time following Licensee’s initial download of the
to use the Software without placing an Order; provided, that the Evaluation Term is subject to e:

Lomee |

Cancel |

oo ]

e
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8. Click Deployment options, and select the Network mappings and Disk provisioning. Click Next.

FIGURE 6 Deployment Options Page

%91 New virtual machine - 1T - IoT

" 1 Select creation type
+ 2 Select OVF and VMDK files
+ 3 Select storage

' 4 License agreements

bd 5 Deployment options

6 Ready to complete

Deployment options

Select deployment ophons

Metwork mappings VM Netwark | Wi Network
Disk provisioning & Thin & Thick
Power on automatically L4

ot | ]

Finizh

Cancel

4
!
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9. Click Ready to complete and review the settings. Click Finish.

FIGURE 7 Ready to Complete Page

+41 New virtual machine - VRIOT

+ 1 Select creation type

+ 2 Select OVF and YMDK files
+ 3 Select storage

+ 4 License agreements

+ 5 Deployment options

bd 6 Ready to complete

Ready to complete

Review your settings selection before finishing the wizard

Product

VM Mame

Files

Datastore
Provisioning type
Metwork mappings

Guest OS Name

B

vriot

VRIOT
vriot-1.6.0.0.38. vmdk
datastore1

Thin

VM Network: VM Network

Unknown

Do not refresh your browser while this VM is being deployed.

I Finish

=2

The RUCKUS IoT Controller login prompt is displayed.
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FIGURE 8 RUCKUS loT Controller Login Prompt

Ruckus loT Caontroller [Running]

[Ruckus IoT Controller

10. Log in to the virtual machine using the username and password.
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11. Enter 1in the Enter Choice field to get the IP address of the virtual machine.

This information is needed to access the RUCKUS loT ControllerInitialization page.

FIGURE 9 Displaying the IP Address

To configure N+1 on the RUCKUS IoT Controller, enter 5 in the Enter Choice field. Refer to "Configuring N+1" in the RUCKUS IloT Controller

Configuration Guide to complete this configuration.

20
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12. Open a web browser on your host machine and enter the IP address of the VM in the address bar.

HTTP and HTTPS on ports 80 and 443 are supported.

The Initialization page is displayed.

FIGURE 10 Intialization Page

Initialization

13. Select the required services and click Next.
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14. Confirm the configuration information and click Next.

The RUCKUS loT ControllerInitialization page is displayed.

FIGURE 11 Confirming the Password

Initialization

Enter new password to continue

Mew Password

Confirm Password Show

15. Enter a new password and re-enter the new password in the Confirm Password field. Click Start.

16. The End-user License Agreement page is displayed. Click Accept to accept the RUCKUS IoT Controller license.

FIGURE 12 End-user License Agreement Page

End-user License Agreement

Ruckus loT Controller (RloT Controller) Software License

PLEASE READ THIS SOFTWARE LICENSE CAREFULLY. RUCKUS WIRELESS, INC. ("RUCKUS") IS WILLING TO LICENSE THE SOFTWARE TO YOU
("LICEMSEE") OMLY OM THE COMDITION THAT THE LICENSEE ACCEPTS ALL OF THE FOLLOWING TERMS AMD CONDITIONS. IF A USER
ACCEPTS THIS LICENSE, OR DOWNLOADS, USES OR INSTALLS THE SOFTWARE, AS AN EMPLOYEE OF, OR AS AN AGENT OR CONTRACTOR
FOR THE BEMEFIT OF, A COMPANY, THAT COMPANY SHALL BE DEEMED THE LICEMSEE AND THE USER REPRESENTS THAT IT HAS THE
POWER AND AUTHORITY TO ACCEPT THIS AGREEMENT ON BEHALF OF THE COMPANY, BY DOWNLOADING, INSTALLING AND/OR USING
THE SOFTWARE, LICENSEE ACKNOWLEDGES THAT IT HAS READ THIS LICENSE AND AGREES TO BE BOUND BY IT5 TERMS AND CONDITIONS.
IF LICENSEE DOES NOT AGREE TO THE TERMS AND CONDITIONS OF THIS LICENSE, RUCKUS |5 UNWILLING TO LICENSE THE SOFTWARE. IN
THAT EVENT, LICENSEE MAY NOT DOWNLOAD, USE OR INSTALL THE SOFTWARE AND SHALL BE GIVEN A FULL REFUND OF ANY LICENSE
FEES ACTUALLY PAID FOR THE SOFTWARE.

1) Definitions

“Device” means @ single Ruckus access point on Licensee’s network. "Documentation” means the published technical manuals, including any
updates thereto, relating to the use of the Software made generally avallable by Ruckus. "Evaluation Term” means the limited period of Eime
following Licersee's initial download of the Software during which Licensese is permitted to use the Software without placing an Order;
provided, that the Evaluation Term is subject to carly termination as provided in this agreement. "Software” means a copy of a machine
executable version of a Ruckus software product that Ruckus makes available to Licensee for downlead onte equipment ewned or controlled
by Licensee, and any error corrections, updates or upgrades of such software product that Ruckus makes available to Licenses. "Order”
MEANs One oF mare ordering documents or transactional recards in the form quuled hy Ruchus from Licenses {or & Ruckus Chanmel Partner

for the benefit of Licensee) to activate the Software or increase the Authorized Device Limit. "Ruckus Channel Partner” means an entity

Close ‘ | Accept
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You are ready to configure and start the RUCKUS loT Controller services. Refer to the RUCKUS loT Controller Configuration Guide for more
information.

Installing a KVM Guest Using virsh Commands

The RUCKUS IoT Controller can be installed on the KVM Guest using virsh commands.

1.
2.
3.

Use the tar -xvf vriot-qcow2-1.6.0.0.x.tar command to extract the vriot-qcow2-1.6.0.0.x.tar file.
Use the sudo mv vriot-1.6.0.0.x.qcow?2 /var/lib/libvirt/images/ command to move the gcow2 image to the libvirt images path..
Use the virsh define vriot-1.6.0.0.x.xml command to define the VM.

NOTE
You must edit the XML file to add it to the network interface

Use the virsh start Ruckus-loT-Controller command to start the virtual machine (VM).

Use the virsh console Ruckus-loT-Controller command to obtain console access to the VM.

Installing a KVM Guest Using Virtual Machine Manager

The RUCKUS IoT Controller can be installed on a KVM guest using Virtual Machine Manager.

1.

Download the RUCKUS loT Controller distribution package in the .tar file format from the RUCKUS Support website at https://
support.ruckuswireless.com.

Use the tar -xvf filename.tar command to obtain the qcow?2 image file and template file.

Open the Virtual Machine Manager.
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4.  From the Virtual Machine Manager menu, select File > Create a New Virtual Machine.

FIGURE 13 Virtual Machine Manager Menu

Virtual Machine Manager

File Edit View Help

|E| Dper
Name 2  (CPU usage
localhost (QEMLU)

The New VM dialog box is displayed.
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5. Enter the name of the virtual machine, select Import existing disk image, and click Forward.

FIGURE 14 New VM Dialog Box Step 1

File Edit View Help

New VM

m Create a new virtual machine

Enter your virtual machine details
Name: |VRIOT-KVM
Connection: localhost (QEMU/KVM)

Choose how you would like to install the operating system
() Local install media (15O image or CDROM)
) Network Install (HTTP, FTP, or NFS)
) Metwork Boot (PXE)

@® Import existing disk image

X

Cancel Back Forward
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6. Enter the path of the .qcow image, the operating system type, and the version number, and click Forward.

FIGURE 15 New VM Dialog Box Step 2

New VM
m Create a new virtual machine

Provide the existing storage path:

,f’h0me,f’vriot—qa—z,f’[)esktopfwiot—BB?a.offline—upgf | Browse...

Choose an operating system type and version

OS type: | Generic =

Version: | Generic

Cancel Back Forward
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7. Select the memory size of RAM (in MB) and the number of central processing units (CPUs) for the virtual machine, and click Forward.

FIGURE 16 New VM Dialog Box Step 3

File Edit View Help

New VM
m Create a new virtual machine

Choose Memory and CPU settings
Memory (RAM): | 4096 . MB
Up to 15929 MB available on the host

CPUs: 4.,
Up to 4 available

Cancel Back Forward
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8. Select Customize configuration before install, and click Finish.

FIGURE 17 New VM Dialog Box Step 4

New VM

E Create a new virtual machine

Ready to begin installation of VRIOT-KVM
0S: Generic
Install: Import existing OS image
Memory: 4096 MB
CPUs: 4

[ Customize configuration before install
0 Specifying an operating system is required For best performance

P Advanced options

Cancel Back Finish

Storage: 1.2 GB fhome/vriot-qa-2/Desktop/vriot-937a.offline-upgrade....

The RUCKUS IoT Controller installation on the virtual manager begins.
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9. After the installation has completed, open the Virtual Machine Manager. Select Disk in the left pane and information about the disk is

Installing RUCKUS loT Controller on Hypervisor
Installing a KVM Guest Using Virtual Machine Manager

displayed. Expand Advanced options and ensure that the disk bus is IDE and the storage format is qcow2.

FIGURE 18 Virtual Disk Configuration

VRIOT-KVM Virtual Machine .

o/ Begininstallation 6 Cancel

Overview

Processor

e

Memory
Boot Options
Disk 1
NIC:27:3e:10

Input
Display VNC

Console
Video Default

l 4.} [«

Add Hardware

Sound: default

Virtual Disk
Target device: Disk 1

Source path: /home/fvriot-qa-2/Desktop/vriot-937a.offline-upgrade.3070.qcow2

Storage size; 1.18GB
Readonly: [
Shareable:

¥ Advanced options
Disk bus: | IDE &
Serial number:

Storage format: |qcowz v

P Performance options
10 Tuning

(7] Tip: 'source’ refers to information seen from the host OS,
while "target' refers to information seen from the guest 05

Remove Cancel

Apply
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10. Select Boot Options in the left pane. Ensure that Start virtual machine on host boot up and Enable boot menu are selected. Select Hard

Disk and click Apply.

FIGURE 19 Boot Options Configuration

VRIOT-KVM Virtual Machine X

Overview
Processor
Memory
Boot Options
IDE Disk 1

NIC :27:3e:10

o fail

Input

Display VNC
Sound: default
Console

L [ZY &

Video Default

Add Hardware

«/ Begin Installation ecancel

Autostart
Start virtual machine on host boot up

Boot device order
Enable boot menu

]

H

P Direct kernel boot

Cancel

Apply
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11. Login to the RUCKUS loT Controller using the username and password.

FIGURE 20 RUCKUS loT Controller Login Prompt

VRIOT-KVM Virtual Machine

File Virtual Machine View SendKey

= [oT Controller

t login: _
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12. Enter 1in the Enter Choice field to get the IP address of the virtual machine.

This information is needed to access the RUCKUS loT Controller Initialization page.

FIGURE 21 Displaying the IP Address

To configure N+1 on the RUCKUS IoT Controller, enter 5 in the Enter Choice field. Refer to "Configuring N+1" in the RUCKUS IloT Controller

Configuration Guide to complete this configuration.

13. Open a web browser on your host machine and enter the IP address of the VM in the address bar.

HTTP and HTTPS on ports 80 and 443 are supported.
The Initialization page is displayed.

14. Select the required services and click Next.
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15. Confirm the configuration information and click Next.

FIGURE 22 Initial VM and IP Configurations

Initialization

The RUCKUS loT ControllerInitialization page is displayed.

FIGURE 23 Confirming the Password

PRUCKUS loT Controller 19T API AR T
Initialization
Enter new password to continue
New Password
Confirm Password m

16. Enter a new password and re-enter the new password in the Confirm Password field. Click Start.
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17. The End-user License Agreement page is displayed. Click Accept to accept the RUCKUS IoT Controller license.

FIGURE 24 End-user License Agreement Page

End-user License Agreement

Ruckus loT Controller (RloT Contraller) Software License

PLEASE READ THIS SOFTWARE LICENSE CAREFULLY. RUCKUS WIRELESS, INC. ("RUCKUS") IS WILLING TO LICENSE THE SOFTWARE TO YOU
{"LICENSEE") OHLY OM THE COMDITION THAT THE LICENSEE ACCEPTS ALL OF THE FOLLOWING TERMS AMD CONDITIONS. IF A USER
ACCEPTS THIS LICENSE, OR DOWNLOADS, USES OR INSTALLS THE SOFTWARE, AS AN EMPLOYEE OF, OR AS AN AGENT OR CONTRACTOR
FOR THE BEMEFIT OF, A COMPANY, THAT COMPANY SHALL BE DEEMED THE LICENSEE AND THE USER REPRESENTS THAT IT HAS THE
POWER AND AUTHORITY TO ACCEPT THIS AGREEMENT QN BEHALF OF THE COMPANY, BY DOWMLDADING, INSTALLING AND/OR USING
THE SOFTWARE, LICENSEE ACKNOWLEDGES THAT IT HAS READ THIS LICENSE AND AGREES TO BE BOUND BY |T5 TERMS AND CONDITIONS.
IF LICENSEE DOES NOT AGREE TO THE TERMS AND CONDITIONS OF THIS LICENSE, RUCKUS IS UNWILLING TO LICENSE THE SOFTWARE. IN
THAT EVENT, LICENSEE MAY NOT DOWNLOAD, USE OR INSTALL THE SOFTWARE AND SHALL BE GIVEN A FULL REFUND OF ANY LICENSE
FEES ACTUALLY PAID FOR THE SOFTWARE,

1) Definitions
“Device” means a single Ruckus access point on Licensees network. “Documentation” means the published technical manals, including any
updates thereto, relating to the use of the Software made generally available by Ruckus. "Evaluation Term™ means the limited period of time
Licensee's initial of the Software during which Licensee is permitted to use the Software without placing an Order;
provided, that the Evaluation Term is subject to early termination as provided in this agreement. “Software”™ means a copy of a machine
executable versien of a Ruckus software product that Ruckus makes available to Licensee for download onto equipment owned or controlled
by Licensee, and any error corrections, updates or upgrades of such software product that Ruckus makes available to Licersee. "Order”
means one o maore erdering documents. or transactional records in the form required by Ruckus from Licensee (or a Ruckus Channel Partner
for the benefit of Licensee) to activate the Software or increase the Authorized Device Limit, "Ruckus Channel Partner” means an entity

Close ] [ Accept

You are ready to configure and start the RUCKUS loT Controller services. Refer to the RUCKUS loT Controller Configuration Guide for more

information.

Installing RUCKUS loT Controller on Hyper-V

The RUCKUS IoT Controller can be installed on Hyper-V using a VHD file.

Installing Hyper-V

1. Extract the VMDK file from the .OVA file using a zip extractor application such as 7-Zip, WinZip, WinRAR, and so on.

2. Convert the VMDK to VHD using a tool such as StarWind V2V Converter or QEMU disk image utility for Windows.

3. From the Windows 10 Start menu, enter Settings, and press Enter.

The Windows Settings page is displayed.

4. Click Apps, and select Apps and Features.

5. Under Related settings, select Programs and Features.

The Uninstall or change program page is displayed.
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6. Select Turn Windows Features on or off.

FIGURE 25 Windows Features

OO0
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B &
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7. Select Hyper-V, and click OK.
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Turn Windows features on or off

Data Center Bridging

Device Lockdown

Guarded Host

Internet Explorer 11

Internet Information Services

Internet Information Services Hostable Web Core
Legacy Components

Media Features

Microsoft Message Queue (MSMQ) Server
Microsoft Print to PDF

Microsoft XPS Document Writer

MultiPoint Connector

Print and Document Services

RAS Connection Manager Administration Kit (CMAK)
Remote Differential Compression API Support
RIP Listener

[ ok |

Installing RUCKUS loT Controller on Hypervisor

Installing RUCKUS loT Controller on Hyper-V

) X

To turn a feature on, select its check box. To turn a feature off, clear its check box.
A filled box means that only part of the feature is tumed on.

Cancel
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8. From the Windows 10 Start menu, enter Hyper-V Manager, and press Enter.
FIGURE 26 Hyper-V Manager App
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9. Click Open.
The Hyper-V Manager page is displayed.
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10. Click the Hyper-V host computer name in the left pane, and select Virtual Switch Manager from the Actions list in the right pane.

The Virtual Switch Manager dialog box is displayed.

FIGURE 27 Creating Virtual Switch

i

File Action View Help
«=| 757 BE

ER Hyper-V Manager
B DESKTOP-BEBTLBE
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[18 Virtual Switch Manager for DESKTOP-BESTLBE

Checkpoil
R
o

Ruckus_3|

=

Summary

ke New Virtual Switch

% _Global Network Settings
§ MAC Address Range
00-15- 00 to 00-15

S Create virual switch

What type of virtual switch do you want to create?

Intemal
| Private

[ Create virual switch |

Creates a virtual switch that binds to the physical network adapter so that virtual

imachines can access a physical network.

e ]

Cangel

Mfigurati...

11. Select the type of virtual switch (External, Internal or Private), click Create Virtual Switch, and click OK. .

The Virtual Switch Properties dialog box is displayed.

12. In the Name field, enter the name of the virtual switch. You can enter additional information in the Notes field.
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Remove Server
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View
Help
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%] Export..
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B Delete..
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13.

14.

Under Connection type, select External network, Internal network, or Private network. If you select External network, select the type of
network adapter you want to use, and select the Allow management operating systems to share the network adapter check box.

Han

File Action View Help

=z HmE

[ Hyper-v Manager
B DESKTOP-BESTLBE

Ruchkus 3

Virtual M3
Mame
B rucs
B Rucus
B Fuckus
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Summary

&8 Virtual Switch Manager for DESKTOP-BESTLBE 2

% Virtual Switches

= New virtual netwerk switch
wha New Virbual Sdtch

i WSwiteh

]

+

wha Deefault Switch
Default Network
® ot New Virtual Switch
Intel(R) Dual Band Wircless-A...
¥ ot Virtual Switch Demo
Intel(R} Dual Band Wireless-A..

+

wha Virtual Switch Properbes

Mame:

virtual Switch Demal

MNotes:

Connection type
‘What do you want to connect this virtual switch ta?
(8) External network:

Inted(R) Dual Band Wireless-AC 3168 “

[ Allow management aperating system to share this network adapter
() Intemal network
() Private nebwork

VLAM ID
[[] Enable virtual LAN identification for management aperating system

Wigurati...

Actions
DESKTOP-BESTLBE

B8 Quick Create...

New

Import Virtual Machine...
Hyper-V Settings...

Virtual Switch Manager...

BB E e

Virtual SAN Manager...
Edit Disk...

| Inspest Disk...

Stop Service

Remove Server
Refresh

[ EON TS

View
Help
chus_3
.E ennect...
Settings...
Start
Checkpoint
Revert...
Move...
Export...
Rename...

Delete...

IWIE P PO K B

Click Apply.

Creating a New Virtual Machine

38

1.

After installing Hyper-V on your computer, you can create new virtual machine. To create Virtual Machine, type Hyper-V Manager in the

search box situated on the taskbar below and press ENTER.

From the Windows 10 Start menu, enter Hyper-V Manager, and press Enter.

The Hyper-V Manager page is displayed.

Click Action tab, select New > Virtual Machine.

The New Virtual Machine Wizard is displayed. You must complete each of the virtual machine configuration options through the wizard.
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4. Under Specify Name and Location, in the Name field, enter the name of the VM. Either store the VM in the default location or select the
Store the virtual machine in a different location check box, and click Browse to select a different location.

FIGURE 28 Specify Name and Location Wizard Page

== Specify Name and Location

Before You Begin Choose a name and location for this virtual machine.
The name is displayed in Hyper-V Manager. We recommend that you use a name that helps you easily
Specify Generation identify this virtual machine, such as the name of the guest operating system or workload.
Assign Memory |Name: New Virtual Machine I
Configure Networking You can create a folder or use an existing folder to store the virtual machine. If you don't select a
Connect Virtual Hard Disk folder, the virtual machine is stored in the default folder configured for this server.
Installation Options => Store the virtual machine in a different location
Summary | Location: |C:\ProgramData\Microsoft\Windows\Hyper-V\ Browse...

& If you plan to take chedkpoints of this virtual machine, select a location that has enough free
space, Checkpoints indude virtual machine data and may require a large amount of space,

< Previous Firish Cancel

5. Click Next.
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6.

7.

Under Specify Generation, select Generation 1 or Generation 2. It is recommended to select Generation 1, because Generation 1 VMs
support 32-bit and 64-bit guest operating systems and BIOS-based architectures.

FIGURE 29 Specify Generation Wizard Page

EH New Virtual Machine Wizard

Before You Begin

Spedify Name and Location

Assign Memory

Configure Networking

Connect Virtual Hard Disk
Installation Options

Summary

Click Next.

ca Specify Generation

Choose the generation of this virtual machine.

@ Generation 1

This virtual machine generation supports 32-bit and 64-bit guest operating systems and provides
virtual hardware which has been available in all previous versions of Hyper-V.

O Generation 2

This virtual machine generation provides support for newer virtualization features, has UEFI-based
firmware, and requires a supported 64-bit guest operating system.

/A, Once a virtual machine has been created, you cannot change its generation.

More about virtual machine generation support

< Previous Finish Cancel
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8. Under Assign Memory, in the Startup memory field, enter the amount of memory that will be assigned to the VM (4096 MB as it is

Installing RUCKUS loT Controller on Hypervisor
Installing RUCKUS loT Controller on Hyper-V

minimum RAM required for RUCKUS loT controller). Select the Use Dynamic Memory for this virtual machine check box to save memory.

FIGURE 30 Assign Memory Wizard Page

E3 New Virtual Machine Wizard
[ Assigh Memory
Before You Begin Specify the amount of memory to allocate to this virtual machine. You can specify an amount from 32
: : MB through 12582912 MB. To improve performance, specify more than the minimum amount
Spedify Name and Location recommended for the operating system,
Spedfy Generation Startup memory: MB
/| Use Dynamic Memory for this virtual machine.
Configure Networking
: 0 When you decide how much memory to assign to a virtual machine, consider how you intend to
e SRR R T use the virtual machine and the operating system that it will run.
Installation Options
Summary
< Previous Finish Cancel
9. Click Next.
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10. Under Configure Networking, select the connection that will be used when connecting the VM to the network. If you have not created a

virtual switch earlier, select Not Connected.

NOTE
Use the default switch for the internal network, and use a different virtual switch with an external network.

FIGURE 31 Configure Networking Wizard Page

=8 New Virtual Machine Wizard X

e Configure Networking

Before You Begin Each new virtual machine indudes a network adapter. You can configure the network adapter to use a
Soecify Mo vl Localion virtual switch, or it can remain disconnected.
Specify Generation Connection: | Not Connected ; ‘
3 Not Connected
BREOn Meshaty Default Switch

Configure Networking Virtual Switch Demo

Connect Virtual Hard Disk

Installation Options
Summary
< Previous Finish Cancel
11. Click Next.
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12. Under Connect Virtual Hard Disk, select Use an existing virtual hard disk to attach an existing virtual hard disk in VHD or VHDX format,

Installing RUCKUS loT Controller on Hypervisor
Installing RUCKUS loT Controller on Hyper-V

and click Browse to select the location of the virtual hard disk.

FIGURE 32 Connect Virtual Hard Disk Wizard Page

EH nNew Virtual Machine Wizard

Before You Begin

Specify Name and Location
Specify Generation

Assign Memory

Configure Networking

Connect Virtual Hard Disk

Summary

13. Click Finish.

RUCKUS IoT Controller Software Installation Guide , 1.8.2.0 MR
Part Number: 800-73057-001 Rev A

= Connect Virtual Hard Disk

A virtual machine requires storage so that you can install an operating system. You can spedify the
storage now or configure it later by modifying the virtual machine’s properties.

() Create a virtual hard disk
Use this option to create a VHDX dynamically expanding virtual hard disk.

New Virtual Machine. vhdx
Cr\Users\Public \Documents \Hyper-V\Virtual Hard Disks)\
Size 127 GB (Maximum: 64 TB)

(®) Use an existing virtual hard disk
Use this option to attach an existing virtual hard disk, either VHD or VHDX format.

Location: |=:\Ruckus.vhd | Browse...

() Attach a virtual hard disk later
Use this option to skip this step now and attach an existing virtual hard disk later.

< Previous Finish Cancel
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14. Open the VM in Hyper-V Manager and from the Actions list in the right pane, click Settings. Confirm the displayed VM configuration
settings such as number of PROCESSOR is 4, RAM size is 4096 MB, and HDD size is 20 GB, click Apply, and click OK.

FIGURE 33 Confirming the VM Settings

B8 Hyper-V Manag
File Action View Help E Settings for Ruckus_vhd _file on DESKTOP-BEETLBE - x
= 2@ Hm [ Ruckus_vhd_fite ¥ 4> |®
[EE Hypes-V Manager | [2 nardware A | B gos et
TSR - 1 [ arercuare DESKTOP-BERTLEE B
Mame g " Bi0s Sedact the ceder in which boot devices are checked to start the operating system. e skl =
B Ruckus_Fisd VHD fle 0 Boat from IDE Startup order I Quick Creste...
H Ruckus_vhd_fle g @ seauity I Mew 4
B Ruckus_vhdx fie G| —-— =t'=-—*-' 2 faacles Ky Metwark e o Ty Import Virual Machine...
Memar e Do =
4095 Floppy 7 Hyper-V Settings...
=0 T‘E“‘:'ﬂ il EB virtual Switch Manager...
B ——y wa Virtual SAN M,
0 e I.uU o Uise a legacy network adapter to perform a network-based instalation of the o sl SANWinrager
E & l:\ur_dDﬂ':t guest operating system. wa Edit Disk...
= B 10E Controler 1 us Inspect Disk...
I_)\'Dorive =) Stop Service
done
&8 scst Controler X Remove Server
B I Network adapter @ Refresh
i :;;1. ';'rllld' Switch View »
None Help
Ruckus_vhd _file -
+F Connect.
Ruckus_vhd_file | Y Settings
l O st
Crested. s Checkpoint
cbl'igllnlh|
Generation: B Move
Hotes: B Export.
& Smart Paging Fie Location *] Rename...
Fihype Rudus_vhd_file
- d B Delete..
| Summary Memary Networking E Cancel Apply Cancel Merge in Progress
[ ot it et} —— )

If you open the VM in Hyper-V Manager and a black screen is displayed, press Ctrl+Alt+End or Ctrl+Alt+Delete after a restart
until the boot screen is no longer visible.
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FIGURE 34 Appearance of Black Screen

1_: Ruckus_vhd_file on DESKTOP-BESTLBE - Virtual Machine Connection - O X

File Action Media Clipboard View Help
B @O nmwf o &
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Creating an Account with AWS

You must creat an account with Amazon Web Service (AWS) and must have the login details for the acount to begin.
To create an account with AWS perform the following steps.

1. Download the AWS CLI on your OS (Operating System).

NOTE
The below installation is performed on Windows 10 operating system.

FIGURE 35 Opening the AWS Command Line Interface User Guide

o

% This section describes how to install, update, and remove the AWS CLI version 2 on Windows.
AWS Command Line x : R

Interface

Liser Guide A Impartant

AWS CLI versions 1 and 2 use the same aws command name. If you have both versions installed, your computer uses the first one
found in your search path. If you previously installed AWS CLI version 1, we recommend that you do one of the following to use
Installing the AWS CL AWS CLI version 2:

v

What Is the AWS CLI?

4

¥ AWS CLl version 2
+ Recommended — Uninstall AWS CLI version 1 and use only AWS CLI version 2. For uninstall instructions, determine the

method you used to install AWS CLI version 1 and follow the appropriate uninstall instructions for your operating system in
Linux Installing, updating, and uninstalling the AWS CLI version 1

Docker

+ Use your operating system's ability to create a symbolic link {symlink) or alias with a different name for one of the two aws

Windows commands. For example, you can use a symbolic link[2 or alias & on Linux and macOS, or DOSKEY [2 on Windows.

» AWS CLl version 1 For information on breaking changes between version 1 and version 2, see Breaking changes - Migrating from AWS CLI version 1
» Configuring the AWS CLI to version 2,
B Using the AWS CLI
b Using the AWS. CLI with AWS Topics

Services = Prerequisites
» Security + Install or update the AWS CLI version 2 on Windows using the MSI installer

Troubleshogting Errors = Uninstall the AWS CLI version 2 from Windows

Migrating/Breaking Changes

Document History

2.  Click the link “Install update AWS CLI version 2 on Windows using the MSi installer".
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Importing the VRIOT Image

Complete the following steps to import the VRIOT image into the AWS shared Amazon Machine Image (AMI).

1.  Open the command line prompt, and execute the below commands.

B Command Prompt =

Visit the “AWSCLI2” folder

Type “aws --version” at the command prompt

Now type “aws configure”

C:\Program Files\Amazon\AWSCLIV2>aws configure

AWS Access Key ID [None]: <enter AWS Access Key ID>

AWS Secret Access Key [None]: <enter AWS Secret Access Key>
Default region name [None]: us-west-2 (all lower case)
Default output format [None]:

2. Create a JSON file called import.json using the following commands. Replace the bucket name with the storage bucket name that you
created.

In this example, the VRIOT image file name as vriot-2.0.0.0.5036.0va.

{

"Description": "Import vriot",
"DiskContainers": [
{
"Description": "vriot-2.0.0.0.5036",
"Format":"ova"

"UserBucket": {
"S3Bucket":"vriot",
"S3Key":"dev-2.0.0.0/6aa8.dev-2.0.0.0.5036/vriot-6aa8.dev-2.0.0.0.5036.0va"

RUCKUS IoT Controller Software Installation Guide , 1.8.2.0 MR
48 Part Number: 800-73057-001 Rev A



3. After creating the “import.json” file, execute the following command.

# aws ec2 import-image --cli-input-json file://import.json

The system displays the below response.

{

"Description": "Import vriot",
"ImportTaskId": "import-ami-0d32al196c9257d5a7",
"Progress": "1",

"SnapshotDetails": [

{

"De

scription": "vriot-2.0.0.0.5036",

"DiskImageSize": 0.0,
"Format": "OVA",

}
] 4

"Status":

"UserBucket": {
"S3Bucket": "vriot",

Installing RUCKUS loT Controller on AWS
Creating a RUCKUS IloT Controller EC2 Instance

"S3Key": "dev-2.0.0.0/6aa8.dev-2.0.0.0.5036/vriot-6aa8.dev-2.0.0.0.5036.0va"

"active",

"StatusMessage": "pending"

4. Enter the following command to verify the status of the imported VRIOT image. Be sure to use the correct import task identifier.

.# aws ec2 describe-import-image-tasks --import-task-ids "import-ami-0d32al96c9257d5a7"

5. Observe the following conversion status response and continue to check the status until conversion is complete. The estimated time for

conversion is 30 minutes.

"ImportImageTasks": [

{

"Architecture": "x86_64",

"Description": "Import vriot",

"ImportTaskId": "import-ami-0d32al96c9257d5a7",
"LicenseType": "BYOL",

"Platform": "Linux",

"Progress": "39",

"SnapshotDetails": [
{
"DeviceName": "/dev/sdal",
"DiskImageSize": 2866090496.0,
"Format": "VMDK",
"Status": "completed",
"UserBucket": {
"S3Bucket": "vriot",

"S3Key": "dev-2.0.0.0/6aa8.dev-2.0.0.0.5036/vriot-6aa8.dev-2.0.0.0.5036.0va"

}
1

4
"Status": "active",
"StatusMessage": "booting",
"Tags": []

Creating a RUCKUS loT Controller EC2 Instance

Complete the following steps to create a RUCKUS loT Controller instance on AWS.

1. Inthe AWS Web Interface, click Compute > EC2.
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2. Navigate to Images > AMIs to ensure that the imported Amazon Machine Image (AMI) exists.
FIGURE 36 Creating an EC2 Instance

FIGURE 37 Dashboard Page

@D Mew EC2 Experience

Tell us what you think X
Resources c
EC2 Dashboard |4
Events You are using the following Amazon EC2 resources in the US West {Oregon) Region:
Tags
- Instances (running) 7 Dedicated Hosts 0
Limits
w Instances Elastic IPs 0 Instances T
Instances we Key pairs 6  Load balancers 1
Instance Types
Placement groups 0 Security groups 23
Launch Templates
Spot Requests Snapshots 3 Volumes 35
Savings Plans
Reserved Instances new (@ Easily size, configure, and deploy Microsoft SQL Server Always On availability groups on AWS using the AWS X

Dedicated Hosts Launch Wizard for SQL Server. Learn more

Scheduled Instances

3. Navigate to Network & Security > Security Groups > Create Security Group.

The security group acts as a virtual firewall that controls the traffic for one or more instances.
4. Define the Setup group name, Description, Ports and the Firewall rule.

The table lists the common service ports.

5. Navigate to Instances and click Instances.

FIGURE 38 Instances Page

O NewEC2 Experience Instances (7) info [C] connect [ instancestate v |[ actions v | [l A

Q 1 @
EC2 Dashboard
Events Instance state: running 3 [ cear fitters
Tags ility Zone « L4 v Elastic IP v IPv6 IPs v Monitoring ¥ Security group name ¥ Key name v Launch time v
Limits Lox i T 4 o disabled vriat-sg nodered-mich,. 2018/06/21 14:21 GMT-7
¥ Instances ~2a e. 23 - - disabled launch-wizard-9 jari-lora 2019/11/18 21:44 GMT-8
Instances ~2a B 7 - - disabled wriot-s5g aws-kp-us-we... 2020/05/06 13:01 GMT-7
Instance Types ~2c B . N - - disabled launch-wizard-8 kp- 2019/12/04 12:07 GMT-8
Launch Templates ~2c B..o 3. - - disabled wriot-sg aws-kp-us-we_.. 2020/08/06 17:23 GMT-T
Spot Requests -2 e.. 3. = - disabled HashiCorp Vault 055-va... aws-kp-us-we... 2020/08/17 13:17 GMT-7
Sayige Mg -2b i B = = disabled launch-wizard-13 prashant 2021/08/16 21:47 GMT-7
Reserved Instances n ]
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6. Select the "Key-Nmae" of the IoT instance

The Port Configuration page is displayed.

FIGURE 39 Port Details

Port Configuration

Instances (1/7) i e v | [ o v | RS
a ! @

= Name ¥ Instance ID Instance state ¥ Instancetype ¥ Status check Alarm status. Public Pvd DNS ¥ PubliciPvdaddress ¥ Elastic 1P

(@) 242 chacks pas s+
- @2 +
[<F: 5+ E;
(=} s + -
+
+ 34.218.41.205
a + 54.189.129.64
Instance: i-084ce62218ed07¢70 - %
2 Tep e000/0 teunch-wizard-13
5000 i a000/0 taunsch-wizard-13
Capacity Resenations 27017 Tcp a0/ aurch-wizard-13
e s883 Tee eo00/0 Kaunsch-wizard-13
AMEs ad% e ©.0.00/0 Launch-wizard-13
: 443 TP Jo launch-wizard-13
¥ Elastic Black Store 4883 Tep 000/ taunch-wizard-13

¥ Outbound rules

Life a q
¥ Network & Security

Part range Pratocol Destination Security groups.

Al All C0.00/0 taunch-wizard-13

£883 TP 0.0.00/0 taunch-wizard-13

4883 e 0.0.00/0 taunch-wizard-13

7. Complete the required port details.
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Upgrading the AP Firmware Using SmartZone 100 or
Virtual SmartZone Controller

You can upgrade the existing AP firmware using a SmartZone 100 controller or Virtual SmartZone.

Always back up the controller before attempting a software upgrade. If you are managing a multi-node cluster, back up the entire cluster, and then
verify that the backup process has completed successfully. If you have an FTP server, back up the entire cluster and upload the backup files from all

the nodes in a cluster to a remote FTP server.

NOTE

RUCKUS strongly recommends backing up the SmartZone 100 controller cluster before performing an upgrade. If the upgrade process

fails for any reason, you can use the latest backup file to restore the controller cluster.

NOTE

Before beginning the upgrade, you must obtain a valid controller software upgrade file from RUCKUS Support or an authorized RUCKUS

reseller.

1. Copy the software upgrade file that you received from RUCKUS to the computer where you are accessing the controller web interface or

to any location on the network that is accessible from the web interface.
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54

2.

From the SmartZone 100 user interface, click Administration > Upgrade.
FIGURE 40 SmartZone 100 User Interface

Truckus™ VRIOTQACLST = s
o = EULTVRYRERVEI L e dcrault il oo O

Upgrade | Upgrads History | AP Paich

Curren t System Information

Upload

[¥] Run Pre-Upgrade Validations (It will take a few minutes to check if the system has sufficlent resources to complete the upgrade)
Upload the patch file {* xime] that you want to use to upgrade the contraller
Browse

Patch for Pending Upgrade

Select the Upgrade tab.

Under Current System Information, the controller version information is displayed.

NOTE
The Upgrade History tab displays information about previous cluster upgrades.

Under Upload, select Run Pre-Upgrade Validations to verify if the data migration was successful. This option allows you to verify data
migration errors before performing the upgrade.

NOTE
You can still upgrade even if there are data migration errors.

Click Browse to select the .ximg patch file.
Click Upload to upload the controller configuration to the configuration in the patch file.

The controller uploads the file to its database, and then performs file verification. After the file is verified, the Patch for Pending Upgrade
section is populated with information about the upgrade file. If data migration was unsuccessful, the following error is displayed:

Exception occurred during the validation of data migration. Please apply the system

configuration backup and contact system administrator.
If the controller configuration upload was successful, perform one of the following steps:
o  Click Upgrade to start the upgrade process without backing up the current controller cluster or its system configuration.

o  Click Backup & Upgrade to back up the controller cluster and system configuration before performing the upgrade.

When the upgrade (or backup-and-upgrade) process is complete, the controller logs you out of the web interface automatically. When the
controller login page displays again, you have completed upgrading the controller.
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8. From the Smartzone 100 user interface, click Access Points.

9. Select the zone from the list, click More, and select Change AP Firmware from the list. The Change AP Firmware dialog box is displayed.
The current AP firmware version is displayed.

FIGURE 41 Changing the AP Firmware

Access Points (8)

System » Aparna

'+_ 2 cp-| % | Moo I
- Bl @
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Typs IONE

6 Qe
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Traffic.

Change AP Firmware

Current AP Firmvare 3.6,1.2.13021

Upgrade 10 3.6.1.2.13022
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Toral Traffic (1hr)

Total APs.

10. Click Upgrade to upgrade to the new firmware version.

FIGURE 42 Upgrading to New Firmware

View Mode:  Lint | Group)| | mean
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If you upgrade to a new firmware, a backup
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backup file to downgrade to original firmware (if
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11. Click Yes. A confirmation message is displayed stating that the firmware version was updated successfully.

FIGURE 43 Update Successful Confirmation Message

X

AP firmware updated successfully.

12. Click OK.
13. Open the RUCKUS IoT Controller. From the Admin tab, click Versions and Patches.

FIGURE 44 Uploading an Image

Admin
Services —
|"‘ Upload Image \ Change Version to : Select - Set;}
Plugins. - . —
\ Upload Patch |
\. J
Account

Patch list
VM Configurations “

Ho Patch Available

DB Backup

Reset & Reboot

14. Click Upload Image and select the tar.gz image.

15. From the Change Version to list, select the image, and click Set.

The RUCKUS IoT Controller is upgraded successfully to the new build.
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Upgrading the RUCKUS loT Controller

RUCKUS recommends not to change or increase HDD allocation from 20GB fixed before upgrading the loT Controller as changing the allocation

results in upgrade failure.

Complete the following steps to upgrade the RUCKUS loT Controller software.

1. From the main menu, click Admin.

FIGURE 45 Upgrading RUCKUS loT Controller

Upgrading the Software
Upgrading the RUCKUS loT Controller

Admin

Services

Plugins

Account

VM Configurations

Versions & Patches

DB Backup

Rules Backup

License

Settings

Reset & Reboot

Upload Image |
- 7

Version list

1.6.0.0.38

e
| Delete | | Set |

Patch list

No Patch Available

Upload Patch

2. Inthe left navigation pane, click Versions & Patches.
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3. Click Upload Image to upgrade to the next version of the release.

FIGURE 46 Uploading the Latest Build

Admin

L5022 alaty sat ) Mo Patch Availabie

1.6.0.0,78 olete | (30t )

4. Select the latest version from the Version list and click Set.
After the controller is upgraded with the new version, it automatically logs out.

5. Login again to the controller.

Upgrading the RUCKUS loT Controller with N+1
Configuration

Complete the following steps to upgrade the primary and secondary RUCKUS loT Controllers with the N+1 configuration.

1. Upgrade SmartZone to the supported version.

NOTE
Refer to Upgrading the AP Firmware Using SmartZone 100 or Virtual SmartZone Controller on page 53 for more information.

2. Upgrade the AP firmware using SmartZone 100 or the Virtual SmartZone Controller.

NOTE
Refer to Upgrading the AP Firmware Using SmartZone 100 or Virtual SmartZone Controller on page 53 for more information.

3. Ensure that the primary controller is active, and the secondary is running.

4. Upload the image file from the primary controller (the same as the normal controller). The image file is automatically copied to the
secondary controller.
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5. Select the version number, and click the Set button.

NOTE
Refer to Upgrading the RUCKUS loT Controller on page 57 for more information.

The RUCKUS loT Controller is re-directed to status page, as shown in the following figure.

FIGURE 47 Displaying the Upgrade Process in N+1 Configuration

Upgrade started in the n+1 machine. Do not refresh

c F F F

- - LY st
Step 1 Step 2 Step 3 Step 4 Step 5
Upgrade Started Secondary Controller

Secondary Controller Primary Contraller Primary Controller
Upgrade/ Downgrade Started Upgrade/Downgrade Complete Upgrade/Downgrade Started

Upgrade/Downgrade Completed

After the secondary controller completes the upgrade, the secondary controller reboots. After step 5, the GUI is redirected to the login
page of the secondary controller. (The primary controller fails over to the secondary controller.)
6.

After a couple of minutes, the primary controller is upgraded and rebooted.
NOTE
If there are no changes to the version list, refer Upgrading the RUCKUS loT Controller on page 57 for more information.

Wait for the primary controller to become active or perform a manual fallback to the primary controller.
Upload the licenses to the controllers.

Refer to Activating a License on page 65 for more information.

Refer to "Configuring the N+1 Feature" in the RUCKUS loT Controller Configuration Guide.
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Hot Upgrade of loT Gateway

The "hot upgrade" of the IoT Gateway supports the offline upgrade of an AP loT bundle from the loT Controller. If the controller is running a current
loT image, the system makes sure the loT version of the APs is upgraded or downgraded to match the current system image. If there is any loT
version mismatch between the AP and the controller, a warning message is displayed on loT AP page.

You can observe the offline upgrade of an AP in the following manner.
1. From the main menu, click loT APs.

The loT Access Points page is displayed.
2. Select an loT AP.

NOTE

If there is any loT version mismatch between the AP and the controller, the following warning message is displayed: "Gateway
loT firmware mismatch".

FIGURE 48 Viewing loT APs
" 201 B8R £G:11- (1911} -
loT Access Points 20:58:69:11:09:10 ®
Moo ) [ s ]
0 loT AP Selected | Pre-Approve loT APs |
P — Hame HAC 1B IP Addres: Protocol: u
) oT APs Sattings
d ® 10.74.136.230 BLE 34| | 10T APs Setting
N
A 20:58:69: 1 1:09:10 20:58:69:11:09:40 Unaveallable m Ho Info Ta Dizplay
Y A B4:79:C8:36: T2:00 B4:79:C8:3E:72:00 Inawailable HA Radio Info
L ] 172.25.124.52 BLE 3 dary 16T Radio Not Detected
™ OCFaD: Lable " ;
A Other Info am
A B T9-CED1:FO: 30 E4:79:CB:01:FD: 30 Unavailabie "
® A casTIEAMN CH08: T3:26:A0:00 naailable HA
e A navallable Ha
) & Unavailable HA

RUCKUS IoT Controller Software Installation Guide , 1.8.2.0 MR

Part Number: 800-73057-001 Rev A 61



Hot Upgrade of loT Gateway

3. From the main menu, click Events to learn more about the warning message.

FIGURE 49 Displaying Events
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Connecting a Set of loT APs Using a Grouping Method

There are two methods to determine which set of loT APs to connect with the loT Controller:
o |solate the IoT APs and non-1oT APs at Layer 2 (VLAN) or Layer 3 (IP) subnets. In this case, DHCP option 43 suboption 21 can be configured
for networks with APs meant to connect with a particular loT Controller. The syntax of suboption 21 is the same as suboption 6 for the Wi-
Fi Controller.
e If network topology cannot be used for grouping, e.g., as a result of customer’s network topology policies, the second method to use is

static configuration method:

NOTE
Running set-iotg-mqtt-broker ip cli script is not recommended for the AP's already connected to the |oT controller.

-  Disable loT processes on all APs.
- Enable loT processes only on loT-enabled APs.
- Set the loT Controller IP address on the loT-enabled APs.

The static configuration method can be accomplished using a vSZ AP CLI script. For example, in vSZ, you create a zone for the group of loT-enabled
APs that you want to connect to a particular IoT Controller. You then apply the vSZ AP CLI script to the zone that enables IoT (set iotg-enable 1) and
set the loT Controller IP address with the set iotg-mqtt-brokerip ip-address command.
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Managing a License
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Activating a License

RUCKUS loT Controller is a licensed product. After purchasing RUCKUS IoT Controller, an email message is sent to you containing an activation code.

Clicking the activation code directs you to the RUCKUS Support website. After the code is validated and attached to a device (the IoT Controller
serial number), the license can be downloaded from the website.

Complete the following steps to activate the license.

NOTE
In an N+1 setup, ensure that individual licenses are installed on both the primary and the secondary controller, respectively.

1.  Click the activation code in the activation email message. You are redirected to the RUCKUS Support website
(support.ruckuswireless.com). Log in to the website using your credentials.

2. Click Activate Purchase. The Activating Your Support Contact & License Code page is displayed. In the Code field, enter your activation
code, and click Validate.

FIGURE 50 Validating the License Code
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3.  After the successful validation of the license code, accept the Terms and Conditions, and click Activate Purchase.

FIGURE 51 Activating Your Support Contract and License Code
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4. Obtain the RUCKUS loT Controller serial number in in one of two ways:
e  Obtain the RUCKUS loT Controller serial number using the RUCKUS IoT Controller console.
a. Login to the console of RUCKUS IoT Controller.
b. Inthe RUCKUS loT Controller Main Menu, enter 2 in the Enter Choice field to get the system details.

FIGURE 52 RUCKUS loT Controller Main Menu

o  To obtain the RUCKUS loT Controller serial number using the RUCKUS IoT Controller user interface, refer to "Uploading the RUCKUS
loT Controller License" in the RUCKUS loT Controller Configuration Guide.
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5. On the Associating Your License With Your Product page, enter the RUCKUS loT Controller serial number, and click Validate Serial

Number to activate the license.

FIGURE 53 Associating the License with the Product
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6. Select the PO1-INT1-WWO0O device model number and click Register Device & Bind To Right To Use.

FIGURE 54 Registering the Device
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Your license information is displayed.
FIGURE 55 License Information
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7. Return to the RUCKUS Support website (support.ruckuswireless.com), and click LIMAN.

FIGURE 56 Accessing Smart License Manager (LIMAN)
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8. Inthe Smart License Manager (LIMAN) page, enter the serial number of the controller, and click the Download Licenses button.

NOTE
The license must be uploaded to the controller.

FIGURE 57 Downloading the License
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